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Планируемые результаты обучения по дисциплине «Спецглавы 

теории управления мехатронными системами»  

 

Целью является формирование у обучающихся знаний, умений и 

приобретение опыта оптимального синтеза систем автоматического 

управления мехатронными системами, а также подготовка студентов 

к решению конкретных задач научно-исследовательской и производ-

ственно-технологической деятельности. 

 

Задачи дисциплины       

 получение представлений о назначении, основных особенностях и 

структурах современных алгоритмов управления, 

 изучение математического описания алгоритмов систем управле-

ния, методов анализа и синтеза цифровых систем управления, 

 изучение современных подходов к формированию программного 

обеспечения систем управления движением в реальном времени; 

 изучение методов построения современных систем адаптивного, 

оптимального и интеллектуального компьютерного управления. 

 

 Процесс изучения дисциплины «Спецглавы теории управления 

мехатронными системами» направлен на формирование следующих 

компетенций  

ПК-1 способностью составлять математические модели мехатрон-

ных и робототехнических систем, их подсистем и отдельных 

элементов и модулей, включая информационные, электроме-

ханические, гидравлические, электрогидравлические, элек-

тронные устройства и средства вычислительной техники 

ПК-

11 

способностью производить расчеты и проектирование от-

дельных устройств и подсистем мехатронных и робототехни-

ческих систем с использованием стандартных исполнитель-

ных и управляющих устройств, средств автоматики, измери-

тельной и вычислительной техники в соответствии с техниче-

ским заданием 
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1. Оптимальный синтез САУ с применением модифицированного 

генетического алгоритма 

 

Цель занятия 

Изучение способа оптимального синтеза САУ, основанного на 

применении генетического алгоритма. 

 

Задание  

1. Изучить материал теоретической части. 

2. Реализовать математическую модель САУ в коде функций 

цели. 

3. Задать два-три критерия оптимизации САУ, учесть их в реа-

лизациях функций цели. 

4. Создать динамически присоединяемые библиотеки, скомпи-

лировав в них программный код функций цели. 

5. Оптимизировать параметры САУ по заданным критериям с 

использованием программного средства GMR. 

6. Оценить результаты оптимизации САУ, представив результа-

ты математического моделирования (в виде графиков, скриншотов и 

т.п.). 

Отчет должен содержать цель работы, задание и практическую 

часть, включающую: 

1. описание моделируемой САУ; 

2. описание критериев оптимизации САУ; 

3. скриншоты главного окна программного средства GMR, 

отображающего начальные условия и результаты оптимизации; 

4. листинги файлов реализации, содержащих описание це-

левых функций; 

5. результаты моделирования САУ с оптимизированными 

параметрами. 

6. выводы по результатам проведенных исследований. 
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Теоретическая часть 

 

Генетические алгоритмы (ГА) применяются для решения мно-

гих конкретных научных и технических проблем, но самое популяр-

ное приложение генетических алгоритмов – оптимизация многопара-

метрических функций. Эффективность ГА определяется их способно-

стью манипулировать одновременно многими параметрами, что явля-

ется крайне необходимым в решении многих прикладных задач, 

включая проектирование интегральных схем, настройку параметров 

алгоритмов, поиск решений нелинейных дифференциальных уравне-

ний и т. д. 

Эффективность применения ГА зависит от характеристик зада-

чи. Если пространство поиска в задаче небольшое, то решение можно 

найти методом полного перебора, и применение ГА не требуется. Ес-

ли пространство гладкое и унимодальное, то любой градиентный ал-

горитм будет эффективнее ГА. Если существует дополнительная ин-

формация о пространстве поиска, то методы поиска, использующие 

эвристики, часто превосходят ГА. Область применения ГА – задачи с 

большим пространством поиска решений и отсутствием эвристиче-

ской информации. 

Кроме того, эффективность ГА зависит от характеристик метода 

кодировки решений, выбора генетических операторов и значений 

инициализирующих параметров. 

Результаты анализа возможностей применения ГА для решения 

задач оптимизации параметров элементов систем автоматического 

управления (САУ) проведены в [2]. 

Опыт многих исследователей алгоритмов управления показал, 

что для простых одноконтурных систем автоматического управления 

(САУ) с линейными регуляторами задачи оптимизации, как правило, 

являются одноэкстремальными. Однако для сложных многоконтур-

ных САУ и систем управления с нейроконтроллерами характерно на-

ряду с глобальным наличие большого числа локальных экстремумов. 

Кроме того, локальные экстремумы появляются и при введении огра-

ничений на пространство поиска. 

Для решения одноэкстремальных задач оптимизации существу-

ет достаточное число градиентных и численных методов. Одним из 

них является метод деформируемого многогранника Нелдера-Мида. 

При оптимизации одноконтурной САУ с ПИ-регулятором примене-
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ние метода позволяет устойчиво находить оптимальные значения на-

строечных параметров pK  и iK  для функции цели вида 

 min)1(),,,( 0,   aItKKF ymip ,   

где 

 
pt

ym dttyI
0

, )(    

– интеграл по модулю регулируемой величины )(ty  на интервале вре-

мени переходного процесса ðt ;  ,0  – соответственно, заданная и те-

кущая степень затухания переходного процесса регулирования; a  – 

масштабный коэффициент, учитывающий вес штрафной функции. 

Применение метода деформируемого многогранника для опти-

мизации двухконтурной САУ с дифференциатором и САУ с нейро-

контроллерами различной структуры приводит к неоднозначности 

решения. В каждом случае результаты зависят от выбранных началь-

ных координат. Из этого следует вывод о многоэкстремальности по-

добных задач, и для их решения требуются методы глобальной опти-

мизации. 

В настоящее время наиболее предпочтительными методами 

многоэкстремальной оптимизации являются ГА, реализующие посту-

латы теории эволюции и опыта селекции растений и животных. Стра-

тегия поиска оптимального решения в ГА опирается на гипотезу се-

лекции: чем выше приспособленность особи, тем выше вероятность 

того, что у потомков, полученных с ее участием, признаки, опреде-

ляющие приспособленность, будут выражены еще сильнее. 

Если принять, что каждая особь популяции является точкой в 

координатном пространстве оптимизационной задачи  liiii xxxX ,...,, 21 , а 

приспособленность особи – соответствующим значением функции 

цели )( iXf , то популяцию особей можно рассматривать как множест-

во координатных точек в пространстве, а процесс эволюции – как 

движение этих точек в сторону оптимальных значений целевой 

функции. 

Следует отметить, что классический ГА находит глобальный 

экстремум в вероятностном смысле. И эта вероятность прямо зависит 

от числа особей в популяции. При оптимизации сложных многокон-

турных и многосвязных систем регулирования и аналогичных систем 

с нейроконтроллерами ГА (в частности, диплоидная версия ГА) с 

достаточно высокой вероятностью находят глобальный экстремум. 

Однако вычисление функции цели, как правило, требует значитель-
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ных вычислительных ресурсов, что существенно сказывается на об-

щем времени расчета решения. 

Особенностью ГА является то, что ни один из генетических 

операторов (кроссовер, мутация, инверсия) в процессе генерирования 

потомков не опирается на знание локального рельефа поверхности 

отклика функции цели. Формирование потомков генетическими опе-

раторами происходит случайным образом, и поэтому нет гарантии, 

что найденные решения будут лучше родительских. Следовательно, в 

процессе эволюции встречается немалое число «неудачных» потом-

ков, которые увеличивают число обращений к функции цели и, тем 

самым, увеличивают время поиска глобального экстремума. 

Кроме того, ГА находят оптимальное решение только внутри 

заданного диапазона поиска. Поэтому диапазоны поиска и число осо-

бей в популяции требуется задавать с большим запасом, что также 

увеличивает время решения. 

Перечисленные особенности сдерживают широкое применение 

ГА в инженерной практике. Однако потребность в таких алгоритмах 

для решения прикладных задач сравнительно небольшой размерности 

постоянно растет, особенно в связи с намечающейся тенденцией вне-

дрения в системы управления нейросетевых технологий. 

В [2] предложен модифицированный ГА (МГА), применение ко-

торого обеспечивает возможность нахождения глобального экстре-

мума с требуемой вероятностью при существенно меньшем, по срав-

нению с диплоидным ГА, числом обращений к функции цели. 

МГА содержит в себе генетические качества статистической се-

лекции популяции поисковых точек. Для исключения «неудачных» 

потомков в нем реализована процедура регулярного поиска локаль-

ных экстремумов с использованием метода деформируемого много-

гранника. При смене поколений в алгоритме заложена рекомендуемая 

во многих источниках 10-процентная замена «неперспективных» 

особей (элиминирование). 

Для инициализации алгоритма необходимо установить: размер-

ность задачи оптимизации N , численность особей в популяции  , 

точность решения задачи   и значения матрицы D , определяющие 

границы интервалов значений координат оптимизируемых векторов 

популяции. 

В общем случае, МГА почти в два раза меньше обращается к 

функции цели по сравнению с диплоидной версией ГА, что вдвое по-

вышает оперативность получения решения. Кроме того, в процессе 
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регулярного поиска МГА способен найти глобальный экстремум за 

пределами заданного диапазона. Перечисленные особенности позво-

ляют заключить, что применение модифицированного ГА в задачах 

многоэкстремальной оптимизации (в частности, параметров элемен-

тов САУ) является более эффективным, чем использование его клас-

сической версии. 

 

Практическая часть 

 

МГА может быть реализован в программном средстве Global 

Minimum Researcher (GMR), предназначенной для решения многопа-

раметрических многоэкстремальных задач оптимизации посредством 

поиска глобального минимума функции цели. Скриншот основного 

окна GMR представлен на рис. 1. 

 
Рисунок 1 – Основное окно приложения «GMR» 

 

На панели «Начальные условия» расположены: 

1. окно «Размерность задачи оптимизации», которое слу-

жит для отображения числа оптимизируемых параметров; 

2. окно «Численность особей в популяции», через которое 

вводится и отображается количество картежей типа <Решение | Зна-

чение функции цели>, обрабатываемых в процессе расчета решения; 

3. окно «Точность решения задачи», необходимое для вво-

да и отображения величины, определяющей максимально допустимое 

рассогласование значений целевой функции, соответствующих полу-

ченным в результате работы программы решениям; 
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4. таблица «Интервалы значений», посредством которой 

вводятся и отображаются идентификаторы и априори определяемые 

границы интервалов значений (область допустимых значений) опти-

мизируемых параметров.  

Размерность задачи оптимизации определяется GMR автомати-

чески, исходя из размера массива, представляющего собой параметр 

функции, экспортируемой из динамически присоединяемой библио-

теки (DLL). 

Численность особей в популяции (ЧОП) влияет на расчет реше-

ния неоднозначно. В случае если оптимизируемая функция является 

унимодальной, то ЧОП влияет только на скорость сходимости. Если 

оптимизируется многоэкстремальная функция, то, помимо скорости 

сходимости, в зависимости от ЧОП находится еще и вероятность на-

хождения глобального экстремума. 

Точность решения задачи определяет размер окрестности гло-

бального минимума, в которой по окончании работы программы 

должны находиться все точки n мерного пространства задачи опти-

мизации, соответствующие особям эволюционировавшей популяции. 

Параметр, определяющий область допустимых значений опти-

мизируемых переменных, влияет на расчет решения в комплексе с 

ЧОП и определяет границы области, в которой строится некоторая 

поверхность при формировании начальной популяции. При этом 

ЧОП определяет уровень разреженности точек поверхности. Чем 

больше размер области допустимых значений и количество точек, 

образующих в ней поверхность, тем более полная информация о ха-

рактере целевой функции передается программе до непосредственно-

го начала поиска. 

Важно отметить, что программа GMR способна находить гло-

бальный минимум, даже в том случае, если он находится за предела-

ми области, определенной пользователем. 

На панели «Полученное решение» расположена таблица ото-

бражения оптимальных значений параметров. 

На панелях «Начальная популяция» и «Эволюционировавшая 

популяция» расположены таблицы отображения решений с соответ-

ствующими значениями функции цели. 

Порядок работы с приложением GMR следующий. Изначально 

необходимо создать DLL, в которую должен быть скомпилирован код 

функции цели, представляющий собой алгоритмическое описание 

модели оптимизируемой САУ. При этом функция цели должна воз-
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вращать значение характеристики качества САУ, по которой осуще-

ствляется оптимизация. Нужно учитывать, что алгоритм GMR пред-

полагает минимизацию значения этой характеристики. 

Для создания библиотеки в интегрированной среде разработки 

Visual C++ (или C++ Builder) необходимо выполнить следующие дей-

ствия. 

1. Выполнить команду File | New | Other и выбрать пиктограмму 

Dynamic-link Library (либо DLL Wizard). Сделать в диалоговом окне 

установки, показанные на рис. 2. Откроется окно Редактора Кода. 

 
Рисунок 2 – Окно задания опций создания DLL 

 

2. Удалить из текста комментарий. 

3. Вставить перед описанием DllEntryPoint директиву включе-

ния головного файла: 

#include "MGA.h"  

Имя файла может быть другим. Файла MGA.h пока нет. Он бу-

дет создан позже. Также, при необходимости, нужно добавить в файл 

реализации директивы включения заголовочных файлов стандартных 

библиотек. 

4. Вставить после описания DllEntryPoint описание функции це-

ли Opt. В теле функции должна быть описана модель САУ, при этом 

функция должна возвращать значение характеристики качества САУ, 

по которой осуществляется оптимизация, то есть программа будет 

выполнять попытку найти такие значения оптимизируемых парамет-

ров САУ, при которых эта характеристика принимает минимальное 

значение. 

5. Сохранить модуль и проект. 

В результате рассмотренных действий файл MGA.cpp (имя фай-

ла может быть другим, здесь для примера операторы тела функции 

возвращают значение функции 2

1

2

0 xxy  ) примет следующий вид: 

#include <windows.h> 

#include <Math.h> 

#include <Math.hpp> 

#pragma argsused 

#include "MGA.h" 
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int WINAPI DllEntryPoint(HINSTANCE hinst, unsigned 

long reason, void* lpReserved) 

{ 

 return 1; 

} 

//---------------------------------------------------

------------------------ 

double Opt (double * x) 

{ 

double y=pow(x[0],2)+pow(x[1],2); 

return y; 

} 

6. Выполнить команду File | New | Other и выбрать пиктограмму 

Header File. Откроется окно Редактора Кода. 

7. Записать в файл следующий код: 
extern "C" double __declspec(dllexport) Opt 

(double * x); 

8. Сохранить файл с именем MGA.h. 

9. Выполнить команду Project | Build MGA. В результате будет 

создан файл MGA.dll. 

Перед компиляцией рекомендуется выключить опции «Build 

with runtime packages» и «Dynamic RTL» на вкладках Project | Options | 

Packages и Project | Options | Linker | Linking соответственно. Это 

обеспечит возможность использования библиотеки в системе, где не 

установлены стандартные библиотеки (пакеты) C++ Builder. 

Скомпилированную библиотеку нужно подключить к GMR, вы-

полнив команду Функция | Загрузить DLL. 

Затем нужно определить идентификаторы и диапазоны допус-

тимых значений оптимизируемых параметров, вызвав двойным 

щелчком мыши по таблице «Интервалы значений» окно, представ-

ленное на рис. 3. 

 

 
Рисунок 3 – Окно настройки свойств оптимизируемых  

параметров 
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После этого становится активной команда Решение | Рассчитать. 

Далее, настроив оставшиеся параметры, необходимо рассчитать ре-

шение. 

Следует отметить, что скорость получения решения оценивается 

количеством итераций (эпох), обеспечивающим сходимость точек, 

соответствующих особям популяции, в окрестности минимума. 

 

Пример 

Качество управления движением мобильного объекта в общем 

случае определяется скоростью его перемещения, точностью отра-

ботки заданной траектории и возможностью осуществления движе-

ния в условиях действия возмущений, то есть устойчивостью движе-

ния. В этой связи рассматриваемая задача заключается в синтезе 

ПИД-регулятора системы управления движением мобильного объек-

та, обеспечивающего оптимальную отработку заданной траектории 

по критерию, комплексно учитывающему быстродействие и точность 

движения. 

 

Постановка задачи 

Введѐм неподвижную систему координат OXYZ  так, чтобы 

плоскость OXY  совпадала с горизонтальной шероховатой плоско-

стью, по которой в вязкой среде движется материальная точка массой 

m  под действием силы F


(рис. 4). 

Материальную точку будем рассматривать как систему, поло-

жение которой в системе OXYZ  определяется вектором обобщенных 

координат 
T

yx , где yx,  – координаты материальной точки. 

 

y

x

Старт

Финиш

X

Y

Z

O

m

V


G


F


N


fr
F


R

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Рисунок 4 – Схема движения материальной точки по шероховатой 

плоскости в вязкой среде 

 

Запишем уравнение движения материальной точки в векторной 

форме 

 RFFam
fr


 ,  (1) 

где a

 – ускорение материальной точки; 

fr
F


 – сила сухого трения; R


 – 

сила вязкого трения. 

В проекциях на оси системы координат OXYZ  уравнение (1) за-

пишем в виде системы дифференциальных уравнений 

 










,

,

yfry

xxfrx

RFFym

RFFxm

y



  (2) 

где yx  ,  – проекции ускорения a

 материальной точки на оси OX  и OY  

соответственно (две точки обозначают двойное дифференцирование 

по времени); 
yx

FF ,  – проекции движущей материальную точку силы 

F


 на оси OX  и OY  соответственно; 
yfrxfr

FF ,  – проекции силы сухого 

трения 
fr

F


 на оси OX  и OY  соответственно; 
yx

RR ,  – проекции силы 

вязкого сопротивления R


 на оси OX  и OY  соответственно. 

Исследование управляемого движения материальной точки 

удобно проводить, используя безразмерные переменные. Осуществив 

тривиальные преобразования, систему уравнений (2) можно привести 

к форме 

 











.
~~~~~

,
~~~~~

yfry

xxfrx

RFFym

RFFxm

y




  (3) 

где m~  – безразмерная масса; yx ~,~  – безразмерные координаты; yx  ~,~  – 

безразмерные проекции скорости V


 материальной точки на оси OX  и 

OY  соответственно; yx  ~,~  – безразмерные проекции ускорения a

 мате-

риальной точки на оси OX  и OY  соответственно; 
yx

FF
~

,
~

 – безразмер-

ные проекции движущей материальную точку силы F


 на оси OX  и 

OY  соответственно; 
yx frfr

FF
~

,
~

– безразмерные проекции силы сухого 

трения 
fr

F


 на оси OX  и OY  соответственно; 
yx

RR
~

,
~

 – безразмерные 

проекции силы вязкого сопротивления R


 на оси OX  и OY  соответст-

венно. 

Примем безразмерную массу материальной точки 1~ m , тогда 

система уравнений (3) примет вид 
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










.
~~~~

,
~~~~

yfry

xxfrx

RFFy

RFFx

y




  (4) 

Для определения 
yx frfr

FF
~

,
~

 из системы уравнений (4) будем ис-

пользовать модель Кулона (модель симметричного сухого трения). В 

соответствии с этой моделью запишем в нотации безразмерных пере-

менных, переход к которым осуществлен с учетом того, что коэффи-

циент трения является безразмерным, следующую систему уравнений 

 











,
~~

,
~~

yfr

xfr

fNF

fNF

y

x

  (5) 

где N
~

 – безразмерная проекция силы реакции шероховатой поверх-

ности N


 на ось OZ ; 
yx

ff ,  – коэффициенты трения, определяемые 

следующим образом: 

 





















,
~~

,0~),
~

(

,
~~

,0~,~

~
,0~),~(

00

0

0

NfFxFsignf

NfFx
N

F

xxsignf

f

xx

x

x

x



























,
~~

,0~),
~

(

,
~~

,0~,~

~
,0~),~(

00

0

0

NfFyFsignf

NfFy
N

F

yysignf

f

yy

y

y

y







 (6) 

где 
0

f  – коэффициент сухого трения. 

yx RR
~

,
~

 из системы уравнений (4) определим с использованием 

линейной модели вязкого трения. В соответствии с этой моделью за-

пишем следующую систему уравнений 

 










.~~~
,~~~

yR

xR

y

x








 (7) 

где ~  – безразмерный коэффициент вязкого трения. 

С учетом (5) и (7) систему дифференциальных уравнений дина-

мики движения материальной точки (4) можно записать в виде 

 










.
~~~~~

,
~~~~~

yfNFy

xfNFx

yy

xx








  (8) 

Сила F


 возникает в результате преобразования управляющего 

значения u : 

 )(ufF


 . (9) 

В скалярной форме в нотации безразмерных переменных урав-

нение (9) можно записать в виде 
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





























,0,
~

,0,0~

,0,0

,0,
~

~

uuk

u
F

u

uuk
F

y

x

 (10) 

где k
~

 – безразмерный коэффициент пропорциональности. 

Пусть 1
~
k , тогда на основе (10) можно записать следующую 

систему уравнений 

 































.0,

,0,0~

,0,0

,0,~

uu

u
F

u

uu
F

y

x

  (11) 

Пусть 
xx

uF 
~

, 
yy

uF 
~

, тогда систему уравнений (11) можно запи-

сать в виде 

 










,
~~~~

,
~~~~

yfNuy

xfNux

yy

xx








 (12) 

где  

 































.0,

,0,0

,0,0

,0,

uu

u
u

u

uu
u

y

x

  (13) 

Система (12) представляет собой систему дифференциальных 

уравнений динамики управляемого движения материальной точки по 

шероховатой плоскости в вязкой среде с безразмерными переменны-

ми.  

В рассматриваемом случае заданной траекторией является s-

образная гладкая кривая — сигмоида (рис. 5), задаваемая функцией 

,
1

)(
*

**

bkxe

a
xy


  

где kba ,,  – параметры сигмоиды. 
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Рисунок 5 – Заданная траектория движения материальной точки 

 

Задача управления заключается в обеспечении оптимального 

движения материальной точки по заданной s-образной траектории от 

точки «Старт» до точки «Финиш» (рис. 4, 5). При этом оптималь-

ность движения характеризуется значением показателя, комплексно 

учитывающего точность и быстродействие САУ при отработке за-

данной траектории. 

 

Система управления движением 

Структурная схема системы управления движением материаль-

ной точки представлена на рис. 6. Система включает регулятор (Р); 

преобразователь управляющего сигнала (П); объект управления (ОУ); 

блок расчета ускорения, сообщаемого материальной точке силой вяз-

кого сопротивления (ВТ); блок расчета ускорения, сообщаемого ма-

териальной точке силой сухого трения (СТ); обозреватель рабочего 

пространства (ОРП). 
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Рисунок 6 – Структурная схема системы управления движением 

материальной точки 

 

Объектом управления является материальная точка, движущаяся 

по шероховатой плоскости в вязкой среде. Влияние окружающей сре-

ды на объект управления реализуется блоками ВТ и СТ. Функциони-

рование блоков ОУ, ВТ и СТ в системе описывается системой урав-

нений (12). 

Блок ОРП реализует расчет отклонения e~  положения матери-

альной точки от заданной траектории (рис. 5).  

Модуль отклонения e~  определяется минимальным расстоянием 

между точкой m  и кривой. Это расстояние равно безразмерной длине 

отрезка, соединяющего точку m  и точку s  кривой, в которой каса-

тельная к кривой перпендикулярна этому отрезку. В рамках предло-

женного алгоритма расчета модуля отклонения e~  точка s  определя-

ется без учета указанного условия следующим образом. Определяют-

ся координаты ))(,( *

aa
xyx  точки кривой a . На первой итерации поиска 

xx
a
 , где x  – текущая координата точки m  по оси .OX  На после-

дующих итерациях 
a

x  увеличивается на 1, если )(* xyy  , либо 

уменьшается на 1, если )(* xyy  . На каждой итерации рассчитывается 

длина отрезка ma  следующим образом: 2*2 ))(()(
aa

xyyxxma  . 

Если значение ma  увеличивается, то цикл прерывается и возвращает-

ся значение ma  из предшествующей итерации. 

Значение e~  определяется следующим образом: 











).(,~~

),(,~~

*

*

xyyee

xyyee
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Преобразователь управляющего сигнала функционирует в соот-

ветствии с соотношениями (13). 

На вход системы подается уставка 0r , что предполагает отсут-

ствие отклонения траектории движения материальной точки от за-

данной траектории. 

Система функционирует в дискретном режиме с безразмерным 

периодом 1
~
T . 

Следует отметить, что прямая, на которой лежит отрезок ms , 

определяющий модуль отклонения положения материальной точки от 

заданной траектории, в общем случае неколлинеарна вектору движу-

щей силы F


, поэтому определение этой силы по отклонению e  явля-

ется задачей, сопряженной с неточностью. 

Качество управления движением q  определяется временем пе-

ремещения материальной точки от точки «Старт» до точки «Финиш» 

и степенью идентичности траектории ее движения заданной. Значе-

ние q  определяется следующим образом: 

 



n

i

ieq
1

~
,  (14) 

где 
i

e~  – безразмерное отклонение от заданной траектории на i-ой ите-

рации управления; n  – число итераций управления, осуществленных 

при движении точки от «Старта» до «Финиша». 

 

Синтез оптимального ПИД-регулятора и результаты моде-

лирования 

В качестве регулятора системы управления движением исполь-

зуется ПИД-регулятор. 

Уравнение ПИД-регулятора в настоящем случае в дискретной 

форме имеет следующий вид: 

 ,~)~~(~

1

И1ДП1 


 
i

р

piiii ekeekeku   (15)

где 
1i

u  – управляющий сигнал на 1i -ой итерации управления, 

ДИП ,, kkk  – соответственно коэффициенты пропорциональности, интег-

рирования и дифференцирования; 
1

~,~
ii

ee  – безразмерные отклонения 

соответственно на i-ой и на 1i -ой итерации управления; 
p

e~  – безраз-

мерное отклонение на p-ой итерации управления.  

Оптимальные значения коэффициентов ДИП ,, kkk  были опреде-

лены с использованием приложения GMR. Скриншот основного окна 
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приложения GMR в режиме расчета коэффициентов усиления ПИД-

регулятора системы управления движением приведен рис. 7. При 

этом «хромосомы» формировались из значений коэффициентов уси-

ления, 05,0
0
f , 1,0 , начальными условиями задачи перемещения 

были: ,10x ,20y  0x , 0y . 

 

 
Рисунок 7 – Скриншот программного приложения, реализующего 

модифицированный генетический алгоритм 

 

Были получены следующие значения коэффициентов усиления: 

9045,6П k , 60295,3И k , 141,0Д k . 

Управляемое движение материальной точки моделировалось с 

использованием разработанного программного приложения, интер-

фейс которого представлен на рис. 8. 
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Рисунок 8 – Скриншот программного приложения моделирования 

управляемого движения материальной точки 

 

Вид траектории движения материальной точки, управляемого с 

применением оптимального ПИД-регулятора, также показан на ри-

сунке 9. 

 

Аппаратные средства и программное обеспечение 

 

Рекомендуется использование интегрированной среды 

разработки Visual C++. 
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Задание на самостоятельную работу 

 

1. Изучить материал теоретической части. 

2. Реализовать математическую модель САУ в коде функ-

ций цели. 

3. Задать два-три критерия оптимизации САУ, учесть их в 

реализациях функций цели. 

4. Создать динамически присоединяемые библиотеки, 

скомпилировав в них программный код функций цели. 

5. Оптимизировать параметры САУ по заданным критери-

ям с использованием программного средства GMR. 

6. Оценить результаты оптимизации САУ, представив ре-

зультаты математического моделирования (в виде графиков, скрин-

шотов и т.п.). 

 

Отчет должен содержать цель работы, задание и практическую 

часть, включающую: 

1. описание моделируемой САУ; 

2. описание критериев оптимизации САУ; 

3. скриншоты главного окна программного средства GMR, 

отображающего начальные условия и результаты оптимизации; 

4. листинги файлов реализации, содержащих описание це-

левых функций; 

5. результаты моделирования САУ с оптимизированными 

параметрами. 

6. выводы по результатам проведенных исследований. 

 

Вопросы для самостоятельной подготовки 

1. Что такое генетический алгоритм? 

2. Каковы области применения генетических алгоритмов? 

3. Каковы основные классы задач, решаемых с помощью генетиче-

ских алогритмов? 

4. Какими параметрами определяется качество управления движе-

ния мобильным объектом? 

5. В чѐм заключается задача управления движения мобильным объ-

ектом? 
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2. Идентификация элементов САУ на базе синтеза искусственной 

нейронной сети прямого распространения 

 

Цель: изучение способа идентификации элементов САУ, 

основанного на синтезе искусственной нейронной сети прямого 

распространения. 

 

Теоретическая часть 

Искусственные нейронные сети (ИНС) – сети с конечным чис-

лом слоев из однотипных элементов – искусственных (формальных) 

нейронов с различными типами связей между слоями. При этом ко-

личество нейронов в слоях выбирается необходимым для обеспече-

ния заданного качества решения задачи, а число слоев нейронов как 

можно меньшим с целью уменьшения времени решения задачи. 

Каждый нейрон характеризуется своим текущим состоянием по 

аналогии с нервными клетками живого организма, которые могут 

быть возбуждены или заторможены. Он обладает группой синапсов – 

однонаправленных входных связей, соединенных с выходами других 

нейронов, а также имеет аксон – выходную связь данного нейрона, с 

которой сигнал (возбуждения или торможения) поступает на синапсы 

следующих нейронов. Структурно-функциональная организация 

формального нейрона представлена на рис. 9. 

Каждый синапс характеризуется величиной синаптической свя-

зи или ее весом wi, который по физическому смыслу эквивалентен 

электрической проводимости. 

 

 
Рисунок 9 – Структурно-функциональная организация искусственно-

го нейрона 

 

Текущее состояние нейрона определяется как взвешенная сумма 

его входов: 
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 



n

i

ii wxS
1

,  (16) 

где n  – число входов нейрона; ix  – значение i го входа нейрона; iw  – 

вес i го синапса. 

Выход нейрона есть функция его состояния 

 )()( 0 SfwSfY  ,  (17) 

где f  – некоторая функция, называемая активационной; 0w – «нейрон-

ное смещение», вводимое для инициализации сети, – подключается к 

неизменяемому входу «+1» (на рис. 9 такой вход не показан). 

Активационная функция может иметь различный вид, как пока-

зано на рис. 10. 

 

 
Рисунок 10 – а) ступенчатая функция; б) линейный порог; 

в) гиперболический тангенс; г) сигмоида 

 

Одной из наиболее распространенных является нелинейная 

функция с насыщением, так называемая логистическая функция или 

сигмоида (т.е. функция s-образного вида): 

 
xe

xf



1

1
)( . (18) 

новится более пологой, при 

.5, при увели-

и-

ничного скачка с порогом T в точке x=0. Из выражения для сигмоиды 

(18) очевидно, что выходное значение нейрона лежит в диапазоне 

(0,1). Одно из ценных свойств логистической функции – простое вы-

ражение для ее производной: 

 ))(1)(()( xfxfxf   .  (19) 

Следует отметить, что логистическая функция является гладкой, 

что используется в некоторых алгоритмах обучения. Кроме того, она 

обладает свойством усиливать слабые сигналы лучше, чем сильные, и 
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предотвращает насыщение от сильных сигналов, так как они соответ-

ствуют областям аргументов, где сигмоида имеет пологий наклон. 

ИНС может рассматриваться как направленный граф со взве-

шенными дугами, в котором искусственные нейроны являются узла-

ми. По архитектуре связей ИНС могут быть сгруппированы в два 

класса: сети прямого распространения, в которых графы не имеют 

петель, и рекуррентные сети, или сети с обратными связями. 

В наиболее распространенном семействе сетей первого класса, 

называемых многослойными персептронами, нейроны расположены 

слоями, связанными однонаправлено. Синтез сети именно такого ти-

па рассматривается в данной работе. 

Сети прямого распространения являются статическими в том 

смысле, что на заданный вход они вырабатывают одну совокупность 

выходных значений, не зависящих от предыдущего состояния сети. 

Функциональные особенности нейронов и способ их объедине-

ния в сетевую структуру обуславливают ту или иную парадигму 

ИНС. Для решения задач идентификации и управления наиболее аде-

кватными, без сомнения, являются многослойные ИНС (МНС) пря-

мого действия или многослойные персептроны (МСП). При проекти-

ровании МНС нейроны объединяются в слои, каждый их которых об-

рабатывает вектор сигналов от предыдущего слоя (или входной век-

тор). Минимальной реализацией является двухслойная ИНС, состоя-

щая из входного (распределительного), промежуточного (скрытого) и 

выходного слоя. При подсчете числа слоев входной слой обычно не 

учитывается, так как служит лишь для распределения входных сигна-

лов по нейронам последующего слоя. На рис. 11 представлена струк-

турная схема двухслойной ИНС прямого распространения. Сигналы в 

сети распространяются от входа к выходу, связи между нейронами 

одного слоя и обратные связи отсутствуют. 

1

11

3

2

4

10w20w

11w21w

12w

22w
13w

23w
14w

24w

22W

12W

21W

11W

20W

10W

(*)2f

(*)1f

(*)2F

(*)1F

2ŷ
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Рисунок 11 – Структурная схема двухслойной нейронной сети 
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Реализация модели двухслойной ИНС прямого распространения 

имеет следующее математическое представление: 

 ))((),(ˆ)(ˆ
1

0

1

0 
 


hn

j

i

n

l

jljljijiii WwwfWFyy


Wwθ ,  (20) 

где n  – размерность вектора входов   нейронной сети; hn  – число 

нейронов в скрытом слое; θ  – вектор настраиваемых параметров ней-

ронной сети, включающий весовые коэффициенты и нейронные сме-

щения ( ijjl Ww , ); )(xf j  – активационная функция нейронов скрытого 

слоя; )(xFi  – активационная функция нейронов выходного слоя. 

Рассмотрим функционирование МНС как совокупности взаимо-

связанных элементов (нейронов) с математической точки зрения. Ка-

ждый структурный элемент МНС получает на входе вектор сигналов 

φ, вычисляет его скалярное произведение на вектор весовых коэффи-

циентов нейрона W  и некоторую функцию F  в выходной сигнал y . 

Результат поступает на входы других нейронов или на выход. Таким 

образом, нейронные сети вычисляют суперпозиции функций одного 

переменного и их линейные комбинации. Для обоснования возмож-

ности использования МНС в качестве моделей динамических систем 

нужно получить ответ на вопрос: можно ли произвольную непрерыв-

ную функцию n  переменных получить с помощью операций сложе-

ния, умножения и суперпозиции функций одного переменного? 

В серии работ А.Н. Колмогорова и В.И. Арнольда решена сле-

дующая математическая проблема (составляющая существо трина-

дцатой проблемы Гильберта): любую непрерывную функцию n  пе-

ременных можно получить с помощью операций сложения, умноже-

ния и суперпозиции из непрерывных функций одного переменного. 

На основе этих работ доказан ряд теорем об аппроксимации непре-

рывных функций многих переменных ИНС с использованием прак-

тически произвольной функции одного переменного. Помимо под-

тверждения общих аппроксимирующих свойств МНС необходимо 

получить ответы на ряд частных вопросов, касающихся структуры 

сети: 

Сколько скрытых слоев должна содержать нейронная сеть? 

Сколько нейронов должно быть включено в каждый слой? 

Какой тип активационной функции должен быть выбран? 

Как отмечено в [1], по мнению некоторых исследователей, лю-

бая непрерывная нелинейная функция может быть аппроксимирована 
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с достаточной точностью ИНС с одним скрытым слоем, содержащим 

нейроны с сигмоидальными (или типа «гиперболический тангенс») 

функциями активации, и выходным слоем, содержащим нейроны с 

линейной активационной функцией. Сделаны попытки исследования 

влияния числа нейронов в скрытом слое на аппроксимирующие свой-

ства сети, однако полученный результат практически невозможно 

применить на практике. 

Возможно, репрезентативные способности МНС могут быть 

улучшены путем введения дополнительных скрытых слоев, особенно 

в случае моделирования сложных взаимосвязей. Однако усложнение 

структуры МНС приводит к значительным трудностям при практиче-

ской реализации, обучении и последующем анализе. Это объясняет 

факт использования именно минимальной реализации МНС в боль-

шинстве технических приложений. 

Предположим, что в результате проведения эксперимента и пред-

варительной обработки данных получено некоторое множество 

  NttytuN ,1)],(),([ Z ,  (21) 

где )(),( tytu  – соответственно входы и выходы системы, N  – число 

дискретных отсчетов. Допустим также, сто выбрана некоторая мо-

дельная структура 

 )()|(ˆ)( tetyty  θ . (22) 

В соответствии с общей схемой реализации процедуры иденти-

фикации следующим этапом является оценка параметров выбранной 

модельной структуры. При использовании нейросетевых модельных 

структур этот этап представляет собой настройку весовых коэффици-

ентов сети в результате реализации процедуры обучения на множест-

ве примеров. Обучение представляет собой отображение множества 

экспериментальных данных на множество параметров нейросетевой 

модели 

 θZ ˆN   (23) 

с целью получения оптимального, в силу некоторого критерия, про-

гноза выходного сигнала ŷ . Традиционно используемым критерием 

является среднеквадратичная ошибка прогнозирования 

 

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),( θθZθ . (24) 

Данный подход относится к классу методов ошибки прогнози-

рования (МОП), так как основной задачей является минимизация 

суммарной нормы ошибки прогнозирования. В некоторых случаях 
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рассматриваются нормы, отличные от квадратичной, которые явля-

ются оптимальными при негауссовом распределении возмущений 

)(te . При использовании критерия в виде (24) МОП соответствует 

оценке методом максимального правдоподобия при условии нор-

мального распределения возмущений )(te . 

Наиболее привлекательной чертой метода является достаточно 

простой алгоритм оценки параметров (весовых коэффициентов) ИНС 

и независимость от возмущений (при условии их нормального рас-

пределения). В ряде случаев данный критерий не является абсолютно 

оптимальным, но в практических приложениях приводит к хорошим 

результатам. 

Для обучения ИНС в большинстве случаев применяется гради-

ентный метод. В основе градиентного метода, или метода наиско-

рейшего спуска, лежит определение направления поиска как проти-

воположного направлению градиента,  т.е. 

 )( )()()()1( iiii G θθθ  .  (25) 

Сходимость метода существенно зависит от выбора шага )(i : 

при достаточно малом шаге обеспечивается уменьшение критерия на 

каждой итерации: ),(),( )()1( Ni

N

Ni

N
VV ZθZθ  . Применение метода к обу-

чению ИНС дает возможность организовать вычисления таким обра-

зом, чтобы рационально использовалась структура конкретной ИНС. 

В этом случае метод называется методом обратного распространения 

(ошибки), или обобщенным дельта-правилом. 

Для выбора шага алгоритма, определяющего скорость сходимо-

сти, могут применяться различные методы, в том числе и адаптивные, 

хотя во многих приложениях используются методы с постоянным 

шагом )(i . 

Независимо от выбора шага, градиентный метод может обеспе-

чить только линейную сходимость, т.е. *)1(*)1(
θθθθ   ii c , )1,0[c . 

Недостаточно высокая скорость сходимости алгоритма делает 

невозможным применение метода для решения задач в режиме ре-

ального времени. Тем не менее, метод может быть эффективно ис-

пользован в нейросетевых приложениях благодаря значительной про-

стоте реализации, скромным требованиям к оперативной памяти и 

возможности использования естественной параллельности алгоритма 

при наличии специализированного аппаратного обеспечения. 
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Практическая часть 

Данные, полученные в результате экспериментов с элементами 

САУ (объектами управления, регуляторами) на стенде, записаны в 

текстовые файлы Lab_2_n.txt (два входа, один выход). Информация, 

содержащаяся в этих файлах, должна использоваться для обучения 

ИНС. 

Изначально необходимо открыть txt-файл (рис. 12). 

 

 
Рисунок 12 – Окно подключения к источнику данных 

 

Затем необходимо задать входные и выходные поля, а также их 

свойства. При этом нужно учитывать следующее. 

Синтезируемая ИНС состоит из входного, выходного и скрытых 

слоев.  Количество нейронов в первом и последнем слое зависит от 

того, сколько полей определено как входные и выходные. Поля, от-

меченные пометкой «не использовать», в обучении и тестировании 

ИНС применяться не будут. 

На вход ИНС должна подаваться информация в нормализован-

ном виде, т.е. числа в интервале [0,1]. Данный интервал называется 

интервалом допустимых значений и определяется функцией актива-

ции нейронов. Нормализация необходима для эффективного исполь-

зования интервала максимальной чувствительности функции актива-

ции. 

В Neural Network Wizard (NNW) реализована возможность вы-

бора метода нормализации. Возможными вариантами являются: ли-

нейная нормализация, экспоненциальная нормализация и авто-
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нормализация, основанная на статистических характеристиках вы-

борки. При необходимости можно изменять параметры конкретного 

метода нормализации. Окно настройки свойств полей представлено 

на рис. 13. 

 

 
Рисунок 13 – Окно настройки свойств полей 

 

Далее нужно указать количество скрытых слоев, количество 

нейронов в них и параметр активационной функции. 

Общего правила, позволяющего определить количество скрытых 

слоев, нет.  Обычно задается 1-3 скрытых слоев. Можно утверждать, 

что чем более нелинейная задача, тем больше скрытых слоев должно 

быть. 

В NNW все элементы предыдущего слоя связаны со всеми эле-

ментами последующего. Количество нейронов в каждом скрытом 

слое также необходимо задать. Общих правил определения количест-

ва нейронов нет, но необходимо, чтобы число связей между нейрона-

ми было меньше количества примеров в обучающей выборке. Иначе 

ИНС потеряет способность к обобщению, а просто «запомнит» все 

примеры из обучающей выборки. Тогда при тестировании на приме-

рах, присутствующих в обучающей выборке, ИНС будет демонстри-

ровать прекрасные результаты, а на реальных данных – весьма пло-

хие. 

Сигмоида применяется для обеспечения нелинейного преобра-

зования данных. В противном случае ИНС сможет выделить только 

линейно разделимые множества. Чем больше значение параметра, 

тем больше активационная функция походит на пороговую. Параметр 
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сигмоиды подбирается эмпирически. Окно настройки параметров 

ИНС представлено на рис. 14. 

 

 
Рисунок 14 – Окно настройки параметров ИНС 

 

После настройки параметров ИНС необходимо настроить пара-

метры обучения, учитывая следующие сведения. 

Все примеры, подаваемые на вход ИНС, делятся на два множе-

ства – обучающее и тестовое, поэтому требуется задать, сколько про-

центов примеров будут использоваться в обучающей выборке. Запи-

си, используемые для тестирования, выбираются случайно, но про-

порции сохраняются. 

Параметр «Скорость обучения» определяет амплитуду коррек-

ции весов на каждом шаге обучения. 

Параметр «Момент» определяет степень воздействия i ой кор-

рекции весов на 1i ую. 

Параметр «Распознана, если ошибка по примеру <» определяет 

максимальную величину ошибки, при которой пример считается рас-

познанным. 

При установке флага напротив «Использовать тестовое множе-

ство как валидационное» обучение будет прекращено с выдачей со-

общения, как только ошибка на тестовом множестве начнет увеличи-

ваться. Это помогает избежать ситуации переобучения нейросети. 

Критерии остановки обучения определяют момент, когда обуче-

ние будет закончено. 

Окно настройки параметров обучения представлено на рис. 15. 
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Рисунок 15 – Окно настройки параметров обучения 

 

После завершения настройки параметров обучения сети необхо-

димо запустить процесс обучение. На рис. 16 представлено окно за-

пуска обучения ИНС и отображения его динамики. 

В таблице над кнопкой можно наблюдать, как меняется ошибка 

обучения. В диаграмме отображается распределение ошибки. Зеле-

ные столбцы – ошибка на обучающей выборке, красные – на тестовой 

выборке. Чем правее столбец, тем выше значение ошибки. Шкала – 

от 0 до 1. Чем выше столбец, тем больше примеров с указанной 

ошибкой. 

На графиках «Распределение примеров в обучающей/тестовой 

выборке» можно отслеживать насколько результаты, предсказанные 

ИНС, совпадают со значениями в обучающей (слева) и тестовой 

(справа) выборках. Каждый пример обозначен на графике точкой. Ес-

ли точка попадает на выделенную линию (диагональ), то ИНС пред-

сказала результат с достаточно высокой точностью. Если точка нахо-

дится выше диагонали, то ИНС недооценила его, ниже – переоцени-

ла. Необходимо добиваться, чтобы точки располагались как можно 

ближе к диагонали. 
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Рисунок 16 – Окно отображения динамики обучения ИНС 

 

По завершению всех рассмотренных выше этапов можно ис-

пользовать синтезированную ИНС как модель элемента САУ. 

На рис. 17 представлено окно, посредством которого осуществ-

ляется расчет на базе синтезированной ИНС. В наборе входных пара-

метров нужно ввести требуемые значения и нажать на кнопку «Рас-

чет». В таблице «Рассчитанные параметры» появится результат. 

Необходимо иметь в виду, что проверять ИНС на числах, выхо-

дящих за границы обучаемой и тестовой выборки, некорректно. На-

пример, если ИНС обучена складывать числа от 0 до 10, то необхо-

димо и тестировать ее на числах из этого диапазона. 
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Рисунок 17 – Окно расчета на базе синтезированной ИНС 

1.1 Задание 

1. Изучить материал теоретической части. 

2. Осуществить идентификацию элемента САУ на базе синтеза 

ИНС прямого распространения, следуя указаниям из практической 

части. 

3. Изменяя параметры ИНС и ее обучения, определить характер 

влияния этих изменений на качество идентификации. Дать качест-

венную оценку установленным зависимостям. 

Отчет должен содержать цель работы, задание и практическую 

часть, включающую: 

1. не менее 5 скриншотов типа рис. 16, отражающих результаты 

обучения при разных параметрах ИНС и обучения; 

2. пояснения к скриншотам; 

3. качественные оценки установленных зависимостей между па-

раметрами ИНС (и ее обучения) и качеством идентификации; 

4. выводы по результатам проведенных исследований. 
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3. Синтез нечеткого регулятора САУ, реализующего алгоритм Мамдани 

 

Цель: изучение способа синтеза нечеткого регулятора САУ, 

реализующего алгоритм Мамдани. 

 

Теоретическая часть 

В алгоритме Мамдани используется минимаксная композиция 

нечетких множеств. Алгоритм включает в себя следующую последо-

вательность этапов: 

1. фаззификацию (приведение к нечеткости); 

2. нечеткий вывод; 

3. дефаззификацию (приведение к четкости). 

Сущность процедуры фаззификации заключается в определении 

степени истинности антецедентов, т.е. значений функций принадлеж-

ности для антецедентов каждого правила. Для базы с m  правилами и 

n  посылками в антецеденте степень истинности обозначается как 
n.1,...,k m,,...,1),( ixkik  

Формирование логического решения осуществляется следую-

щим образом.  

Изначально определяются уровни «отсечения» для антецедента 

каждого из правил: 

 ))((min kik
i

i xalfa   (26) 

Далее находятся «усеченные» функции принадлежности консек-

вента: 

 ))(,(min)(' yalfay ii
i

i    (27)

  

Затем осуществляется композиция полученных усеченных 

функций, для чего используется максимальная композиция нечетких 

множеств: 

 ))((max)( ' yy i
i

  , (28) 

где )(y  – функция принадлежности итогового нечеткого множества.  

Последним этапом является дефаззификация, которая заключа-

ется в приведении к четкости результата композиции множеств на 

предыдущем этапе. В алгоритме Мамдани применяется метод центра 

тяжести (центроидный метод): 

 


 


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На рис. 18 представлена графическая интерпретация нечеткого 

вывода по Мамдани для двух входных переменных '

1X  и '

2X  и двух не-

четких правил R1 и R2. 

1 1 1

1 1 1

min
)(),( 11 yy


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y
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Рисунок 18 – Графическая интерпретация нечеткого вывода по  

Мамдани 

Также существуют другие алгоритмы нечеткого вывода (Сугено, 

Ларсена, Цукамото). От алгоритма Мамдани они отличаются: 

1. видом используемых правил; 

2. типом логических операций; 

3. методом дефаззификации. 

 

Практическая часть 

Синтезируемый регулятор САУ представляет собой нелинейный 

преобразователь с несколькими входами и одним или несколькими 

выходами. Для примера предположим, что посредством эксперимен-

тов на стендовом оборудовании определено, что аппроксимация за-

висимости, реализуемой регулятором, имеет вид, приведенный на 

рис. 19.  
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Рисунок 19 – График аппроксимации зависимости, реализуемой регу-

лятором 

 

Поверхности на рис. 19 ставится в соответствие следующие 

семь нечетких правил: 

1. ЕСЛИ 1x = «Низкий» И 2x  = «Низкий», ТО y  = «Высокий»; 

2. ЕСЛИ 1x = «Низкий» И 2x  = «Средний», ТО y  = «Низкий»; 

3. ЕСЛИ 1x = «Низкий» И 2x  = «Высокий», ТО y  = «Высокий»; 

4. ЕСЛИ 1x = «Средний», ТО y  = «Средний»; 

5. ЕСЛИ 1x = «Высокий» И 2x  = «Низкий», ТО y  = «Выше сред-

него»; 

6. ЕСЛИ 1x = «Высокий» И 2x  = «Средний», ТО y  = «Ниже сред-

него»; 

7. ЕСЛИ 1x = «Высокий» И 2x  = «Высокий», ТО y  = «Выше 

среднего». 

Синтез нечеткого регулятора для рассматриваемого примера со-

стоит в соответствии с [3] в выполнении следующей последователь-

ности шагов в вычислительной среде MATLAB. 

1. Открыть FIS-редактор, напечатав слово fuzzy в командной 

строке. После этого появится новое окно, показанное на рис. 20. 

2. Добавить вторую входную переменную (Edit->Add Variable-

>Input).  
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Рисунок 20 – Окно FIS-редактора 

 

3. Переименовать входные и выходную лингвистические пере-

менные в поле Name FIS-редактора. 

4. Сохранить проект (File->Export->To Disk). 

5. Перейти в редактор функций принадлежности двойным 

щелчком левой кнопки мыши на блоке 1x . 

6. Задать диапазон изменения переменной 1x , напечатав -7 3 в 

поле Range и нажав Enter. 

7. Задать функции принадлежности термов лингвистической пе-

ременной 1x . Для лингвистической оценки этой переменной предлага-

ется использовать три терма с треугольными функциями принадлеж-

ности. Задать наименования термов переменной («Низкий», «Сред-

ний», «Высокий»), выделив их функции принадлежности и отредак-

тировав поле Name (рис. 21.). 

 



 

39 

 

 

 
Рисунок 21 – Окно редактора функций принадлежности 

 

8. Перейти в редакторе функций принадлежности к переменной 

2x . Проделать шаги 6-7 для переменной 2x . Единственным отличием 

здесь будет диапазон. 

9. Перейти в редакторе функций принадлежности к блоку y . 

Для лингвистической оценки этой переменной предлагается исполь-

зовать пять термов с гауссовыми функциями принадлежности. 

10. Задать диапазон изменения переменной y , напечатав -50 50 

в поле Range и нажав Enter. 

11. Удалить функции принадлежности, установленные по 

умолчанию, выполнив Edit->Remove All MFs.  

12. Добавить гауссовы функции принадлежности, выполнив 

Edit->Add MFs и выбрав в появившемся диалоговом окне MF type = 

gaussmf, Number of MF’s = 5. Задать следующие наименования тер-

мов переменной y : «Низкий», «Ниже среднего», «Средний», «Выше 

среднего», «Высокий».  

13. Перейти в редактор базы знаний, выполнив Edit->Rules. 

14. Для ввода правила необходимо выбрать в меню соответст-

вующую комбинацию термов и нажать Add rule. Окно редактора пра-

вил представлено на рис. 22. В конце каждого правила в скобках ука-

зан весовой коэффициент. 
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Рисунок 22 – Окно редактора правил 

 

15. Сохранить проект (File->Export->To Disk). 

16. Выполнить View->Rules. Появиться окно визуализации не-

четкого вывода (рис. 23). 

 

 
Рисунок 23 – Окно визуализации нечеткого вывода Мамдани 

 

17. Выполнить View->Surface. Появится окно с изображением 

поверхности «входы – выход», соответствующей синтезированному 

нечеткому регулятору (рис. 24). 
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Рисунок 24 – Окно просмотра поверхности 

 

 

 

1.2 Задание на самостоятельную работу  

 

1. Изучить материал теоретической части. 

2. Самостоятельно выбрать и представить графически нелиней-

ную зависимость, которую должен реализовать синтезируемый регу-

лятор САУ. Входов должно быть не менее двух, может быть более 

одного выхода. 

3. Синтезировать нечеткий регулятор САУ, реализующий алго-

ритм Мамдани.  

4. Сравнить вид выбранной зависимости «входы – выходы» с 

видом зависимости «входы – выходы», которая соответствует синте-

зированному нечеткому регулятору САУ. Сделать вывод. 

Отчет должен содержать цель работы, задание и практическую 

часть, включающую: 

1. скриншоты типа рис. 19, 21-24 с пояснениями; 

2. качественную оценку сравнения выбранной вида зависимости 

«входы – выходы» с видом зависимости «входы – выходы», которая 

соответствует синтезированному нечеткому регулятору САУ; 

3. выводы по результатам проведенных исследований. 
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4. Идентификация элементов САУ на базе синтеза нечеткой ней-

ронной сети типа ANFIS 

 

Цель: изучение способа идентификации элементов САУ, 

основанного на синтезе нечеткой нейронной сети типа ANFIS. 

 

Теоретическая часть 

ANFIS (Adaptive Network based Fuzzy Inference System) пред-

ставляет собой пятислойную нейро-нечеткую сеть прямого распро-

странения сигнала, реализующую нечеткий вывод Сугено. Архитек-

тура ANFIS-сети представлена на рис. 25. 

 

 
Рисунок 25 – Архитектура ANFIS-сети 

 

На рис. 25 изображена ANFIS-сеть с двумя входными перемен-

ными ( 1x  и 2x ) и четырьмя нечеткими правилами. Для лингвистиче-

ской оценки входной переменной 1x  используется три терма, для 2x  – 

два терма. 

Введем обозначения, необходимые для дальнейшего изложения: 

1. nxxx ,...,, 21 – входы сети; 

2. y  – выход сети; 

3. rR : Если rax ,11   И…И rnn ax , , то nrnrr xbxbby ,1,1,0 ...  – нечеткое 

правило с порядковым номером r ; 

4. m  – количество правил, mr ,1 ; 

5. ria ,  – нечеткий терм с функцией принадлежности )( ir x , при-

меняемый для лингвистической оценки переменной ix  в r -ом правиле 

( nimr ,1,,1  ); 

6. rqb ,  – коэффициенты в заключении r -го правила ( nqmr ,0,,1  ). 

ANFIS-сеть функционирует следующим образом. 
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Каждый узел первого слоя представляет один терм с, как прави-

ло, колоколообразной функцией принадлежности (могут использо-

ваться и другие типы функций). Входы сети nxxx ,...,, 21  соединены толь-

ко со своими термами. Количество узлов первого слоя равно сумме 

мощностей терм-множеств входных переменных. На выход узла по-

дается степень принадлежности значения входной переменной соот-

ветствующему нечеткому терму: 

 
b

i

ir

a

cx
x

2

1

1
)(




 ,  (30) 

где cba ,, – настраиваемые параметры функции принадлежности. 

Количество узлов второго слоя равно m . Каждый узел этого 

слоя соответствует одному нечеткому правилу. Узел второго слоя со-

единен с теми узлами первого слоя, которые формируют антецеденты 

соответствующего правила. Следовательно, каждый узел второго 

слоя может принимать от 1 до n  сигналов. Выходом узла является 

степень выполнения правила, которая рассчитывается как произведе-

ние входных сигналов. Обозначим выходы этого слоя через r , mr ,1 . 

Количество узлов третьего слоя также равно m . Каждый узел 

этого слоя рассчитывает относительную степень выполнения нечет-

кого правила по формуле: 
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 . (31) 

Количество узлов четвертого слоя также равно m . Каждый узел 

соединен с одним узлом третьего слоя, а также со всеми входами сети 

(на рис. 25 связи с входами не показаны). Узел четвертого слоя рас-

считывает вклад одного нечеткого правила в выход сети по такой 

формуле: 

 )...( ,1,1,0

*

nrnrrrr xbxbby  .  (32) 

Единственный узел пятого слоя суммирует вклады всех правил: 
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Типовые процедуры обучения нейронных сетей могут быть 

применены для настройки ANFIS-сети, так как в ней используются 

только дифференцируемые функции. Обычно применяется комбина-

ция градиентного спуска в виде алгоритма обратного распростране-

ния ошибки (АОРО) и метода наименьших квадратов (МНК). АОРО 

настраивает параметры антецедентов правил, т. е. функций принад-

лежности. Посредством применения МНК оцениваются коэффициен-
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ты заключений правил, так как они линейно связаны с выходом сети. 

Каждая итерация процедуры настройки выполняется в два этапа. На 

первом этапе на входы подается обучающая выборка и по невязке 

между желаемым и действительным поведением сети посредством 

применения МНК находятся оптимальные параметры узлов четверто-

го слоя. На втором этапе остаточная невязка передается с выхода сети 

на входы и на базе АОРО модифицируются параметры узлов первого 

слоя. При этом найденные на предыдущем этапе коэффициенты за-

ключений правил не изменяются. Итерационная процедура настройки 

продолжается, пока невязка превышает заранее установленное значе-

ние. 

 

Практическая часть 

Данные, полученные в результате экспериментов с элементами 

САУ (объектами управления, регуляторами) на стенде, записаны в 

текстовые файлы Lab_3_n.txt (150 записей, два входа, один выход). В 

обучающую выборку включается 120 записей, в тестовую – 30. Обу-

чающая (tr_set) и тестовая (test_set) выборки формируются в рабочей 

области среды MATLAB следующим образом: 

samp=load('Путь к файлу\Lab_3_n.txt'); 

samp_number=length(samp); 

test_index=[6:10:samp_number 7:10:samp_number]; 

tr_index=setdiff(1:samp_number, test_index); 

tr_set=samp(tr_index, [1 2 3]); 

test_set=samp(test_index, [1 2 3]); 

Далее командой anfisedit необходимо запустить ANFIS-

редактор, в котором будет сгенерирована и обучена нечеткая система 

в соответствии с [3]. Для загрузки обучающей выборки в окне ANFIS-

редактора (рис. 26) в поле Load data нужно выбрать опции Training 

(меню Type) и worksp. (меню From) и нажать кнопку Load Data…. 
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Рисунок 26 – Основное окно ANFIS-редактора 

 

В результате появиться окно (рис. 27), в котором требуется вве-

сти идентификатор обучающей выборки tr_set. Для загрузки тестовой 

выборки нужно установить опцию Testing в меню Type, нажать Load 

Data… и в появившемся окне набрать test_set. После этих действий 

ANFIS-редактор будет выглядеть так, как показано на рис. 28. 

 

 
Рисунок 27 – Окно ввода имени переменной в ANFIS-редакторе 

 
Рисунок 28 – Окно ANFIS-редактора после загрузки обучающей и 

тестовой выборок 
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Данные обучающей выборки показаны окружностями, а тесто-

вой выборки – точками. 

Для создания исходной системы нечеткого вывода требуется 

нажать кнопку Generate FIS…. По умолчанию используется простой 

метод решетчатого разбиения (Grid partition), согласно которому 

функции принадлежности нечетких термов равномерно распределя-

ются внутри диапазона изменения данных. База знаний содержит все 

возможные варианты правил. Коэффициенты в заключениях правил 

принимаются равными нулю. 

Теперь с нечеткой системой можно работать, используя GUI-

модули пакета Fuzzy Logic Toolbox. Вызов этих модулей осуществля-

ется через меню Edit и View. Для изображения синтезированной сис-

темы в виде нейро-нечеткой сети (рис. 29) необходимо нажать кнопку 

Structure в поле ANFIS Info. 

 

 
Рисунок 29 – Архитектура синтезированной нейро-нечеткой сети 

 

Обучение нечеткой системы запускается после задания критерия 

его остановки. Критерием остановки может быть число итераций ли-

бо величина ошибки. 

Для запуска обучения в поле Epochs меню Train FIS нужно вве-

сти число итераций и нажать Train Now. Динамика обучения выво-

дится в основном окне ANFIS-редактора (рис. 30): ось абсцисс соот-

ветствует итерациям алгоритма обучения, а ось ординат – значениям 

среднеквадратичной ошибки. 
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Рисунок 30 – Динамика обучения нечеткой системы 

 

Для проверки модели на тестовой выборке требуется установить 

в поле Test FIS опцию Testing data и нажать Test Now. Результаты 

тестирования выводятся в основном в окне ANFIS-редактора (рис. 

31). Экспериментальные данные показаны точками, а результаты мо-

делирования – звездочками. 

 

 
Рисунок 31 – Окно с результатами тестирования нечеткой системы 
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Далее выполняется идентификация параметров линейной и 

квадратичной модели. 

Идентификация параметров линейной модели 22110 xaxaay   и 

расчет ее ошибок на обучающей и тестовой выборках осуществляют-

ся на базе следующего программного кода: 

N=length(tr_set); 

NN=length(test_set); 

X=[ones(N,1) tr_set(:,1) tr_set(:,2)]; 

A=X\tr_set(:,3); 

Out_model=X*A; 

rmg_tr=norm(tr_set(:,3)-Out_model)/sqrt(N); 

X_test = [ones(NN,1) test_set(:,1) test_set(:,2)]; 

Out_model = X_test*A; 

rmg_ch=norm(test_set(:,3)-Out_model)/sqrt(NN); 

Идентификация параметров квадратичной модели 

215

2

24

2

1322110 xxaxaxaxaxaay   и расчет ее ошибок на обучающей и 

тестовой выборках осуществляются на базе следующего программно-

го кода: 

X=[ones(N,1) tr_set(:,1) tr_set(:,2) tr_set(:,1).^2 tr_set(:,2).^2 

tr_set(:,1).*tr_set(:,2)]; 

A=X\tr_set(:,3); 

Out_model = X*A; 

rmg_tr=norm(tr_set(:,3)-Out_model)/sqrt(N); 

X_test=[ones(NN,1) test_set(:,1) test_set(:,2) test_set(:,1).^2 

test_set(:,2).^2 test_set(:,1).*test_set(:,2)]; 

Out_model=X_test*A; 

rmg_ch=norm(test_set(:,3)-Out_model)/sqrt(NN); 

 

Задание на самостоятельную работу 

1. Изучить материал теоретической части. 

2. Осуществить идентификацию элемента САУ на базе синтеза 

нечеткой нейронной сети типа ANFIS, следуя указаниям из практиче-

ской части. Изменяя параметры ANFIS и ее обучения, определить ха-

рактер влияния этих изменений на качество идентификации. Дать ка-

чественную оценку установленным закономерностям. 

3. Осуществить идентификацию параметров линейной и квадра-

тичной моделей, используя программный код, представленный в 

практической части. 
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4. Сравнить результаты идентификации на базе синтеза ANFIS, 

линейной и квадратичной регрессий. 

Отчет должен содержать цель работы, задание и практическую 

часть, включающую: 

1. все скриншоты, представленные в практической части (за ис-

ключением рис. 26 и 27), отражающие ход решения задачи иденти-

фикации на базе синтеза ANFIS; 

2. скриншот с изображением поверхности «входы – выход», со-

ответствующей нечеткой модели элемента САУ; 

3. значения среднеквадратичных ошибок полученных моделей; 

4. выводы по результатам проведенных исследований. 
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